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About this Book 

This Participant Handbook is designed to enable training for the Color Key Artist Qualification Pack 

(QP) with Ref. ID MES/ Q 0505. There are 4 National Occupational Standards (NOS) under this 

qualification pack. Each National Occupational (NOS) is covered across 8 Units in this book.  

Key Learning Objectives for every NOS mark the beginning of the Unit for that NOS. In Table of 
Contents, you will find the module names with their corresponding NOS code.  The symbols used in 
this book are described below. 
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Key Learning Outcomes  

At the end of this module, you will be able to: 

1. Explain the key features of the Media and Entertainment sector 

2. Discuss various processes and products of Media & Entertainment sector 

3. Learn about the role of Color Key Artist in industry. 

4. Identify the minimum requirement to become a certified Color Key Artist. 

5. Describe the work area of Color Key Artist. 

6. Identify the opportunities available for Color Key Artist. 
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UNIT 1.1: Introduction to Media & Entertainment 

 

Unit Objectives 

At the end of this unit, you will be able to:  

1. Describe the media and entertainment industry in India 

2. Describe the growth expected in the media & entertainment industry 

3. Explain the various products and processes of the industry 

4. Identify some keywords used in the industry 

 

1.1.1 Media and Entertainment Sector in India 

The Indian media and entertainment (M&E) sector is one of the biggest in the world. It is placed as 

14th largest in the world. This sector is 1.7% of Indian GDP and expected to be 2.2% of GDP with INR 

4.5 lakh crores in 2022. The sector employs 9.3% of the workforce of our country and we are expecting 

it to be 17% till the end of 2017 

From 2014 to 2018 Media and Entertainment sector has grown by approximately 11 percent CAGR 

which makes Media and Entertainment sector INR 1.43 trillion industry. It is estimated that Indian 

Media and Entertainment market will flourish to CAGR of 13.1% in FY 18-23 reaching at INR 2.66 

trillion. The industrial performance of M&E sector is given in next figure. 

 

Figure 1.1. 1 Revenue of M&E Industry 

In 2018, digital advertising business grew 35% as compared to 2017. Another high growth sub-sector 

is Gaming which grew by 35.1% in FY 2018 as compared to FY 2017. The projected growth of industry 

for FY 2018 to 2023 is given in next figure. 
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Figure 1.1. 2 Projected growth of M&E Sector 

India is one of the largest broadcasters in the world with approximately 800 TV channels, 242 FM 

channels and more than 100 community radio networks working at present. Bollywood, the Indian 

film industry is the largest producer of films around the globe with 400 production and corporate 

houses involved. 

The Government of India keeps on pushing the Media and Entertainment industry by launching 

various schemes such as digitizing the cable TV to fill greater institutional funding, raising the 

Foreign investment from 74 per cent to 100 per cent in cable and DTH satellite platforms. 

Government has also allotted industry status to the film industry for easy finance. 

 

1.1.2 Employability in Media and Entertainment Sector 

The Media & Entertainment sector employs 11-12 lakh people directly (as per 2017 reports) and if 
we consider indirect employments as well then count goes to 35-40 lakh people. The Media sector is 
highly dependent on advertising revenues and performance of Industry for economy outlook. This 
sector was having 4 lakhs workforce in 2013 and we expect it to reach 13 lakhs by 2022 which 
means employing 9 lakhs of additional employment in the period of 2013-22. 
 

• 1/4th of the people employed in Media and Entertainment sector are from film industry. 

• The Media & Entertainment sector has about 4.60 lakhs people employed, and is projected to 

grow at the rate of 13 % to reach 7.5 lakhs by 2017. 

• The Media and Entertainment sector which is expected to grow at rate of 13.1 % by 2023 which 

means to reach 2.7 lakh crore of business for skilled professionals.  

• Film & Television sector has a major portion of the workforce employed in media and 
entertainment. Digitization activities being done in both films and television arena are the key 
player for this demand. 
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Figure 1.1. 3 Employments in Different Sectors of Media and Entertainment 

1.1.3 Evolution of Media and Entertainment Sector 

• Radio broadcasting came by Radio Club of Bombay in 1923 in India under the British rule. 

• All India Radio (AIR), one of the largest radio networks in the world, started working in 1936. 

• Doordarshan (DD) started the era of TV on Sept 15, 1959 in India. 

• The Indian economy was closed until 1990, and no private player was allowed to enter the space 

In the 1990s, the Indian film industry was completely fragmented 

• BBC launched its national service in 1995 

• In 1999, the government allowed private Indian Firms to set up their FM stations on a license fee 

basis 

• In May 2000, as part of Phase I of radio broadcast licensing, the auction was conducted and 37 

licenses were issued, out of which 21 are operational in 14 cities 

• Approximately 1000 TV channels and 1052 radio stations are expected to be working by 2022. 
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1.1.4 Major Subsector and Segments 

• The Indian M&E industry comprises several sub-sectors, such as television, radio, print media 

(including newspapers and magazines), films, animation and visual effects (VFX), Sound & Music, 

Amusement & Theme Parks, Art & Culture, and Event Management/Live Performances. 

• Advertising industry is the major revenues generating part of the industry and the growth of the 

sector decides the overall growth of the industry. 

• Although there is not much to export from this industry but imports have a considerable share in 

the economy like imports of newsprints, set-top boxes and antennae. 

 

 

Figure 1.1. 4 Media and Entertainment Sector 

 

• The industry is specific to cultural and ethnic backgrounds, and is organized around specific 

hubs that specialize in output for a given population segment. For example, the Mumbai film 

industry (Bollywood) is a key film hub in the country. A similar hub also exists in South India.  
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Figure 1.1. 5 Media and Entertainment Sector Growth Rates expected in 2016-2021 

1.1.5 General Key Words used in this Book 

Animatic: A series of images edited together with dialogues and sound is called animatic. 

Compositing: Combining layers of images/elements into a single frame is called composting. 

Composition: Positioning character with respect to the background and camera is called composition. 

Creative Brief: A document that captures the key questions for the production including the vision, 

objective of the target audience, budgets, project, milestones, timelines and stakeholders is called 

creative brief. 

Key Frame: Key poses that start and end poses for a particular animation sequence are called key 

frames.  

Modeling: Creation of three-dimensional models for animation using a specialized software is called 

modelling. 

Rendering: Conversion of three-dimensional models into two-dimensional images with 3D effects is 

called rendering. 

Rigging: Process of adding joints to a static three-dimensional model to aid movement during posing 

is called rigging. 

2D animation: Moving pictures in a two-dimensional environment is called 2D animation like in 

computerized animation software. 

3D animation: 2D animation with depth is called 3D animation. Examples include video games such 

as Halo and Madden Football. 

Animation:  Sequential play of various inter-related frames is called animation. 

Anticipation: Anticipation are created through the preparation of an action. 
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Aspect Ratio: The width to height ratio of a tv picture is called aspect ratio. 

Background Painting: An artwork done in the background of an animation is called background 

painting. 

CGI (Computer Generated Imagery): Creation of Figures, settings, or other material in the frame using 

computer software is called CGI. 

Clean-Up: The process of refining the rough artwork of 2D animation is called Clean-up. 

Computer Animation: Any kind of animation created in computer is called computer animation. 

Frame: one of a series of still transparent photographs on a strip of film used in making movies or 

animations. 

Frame Rate: The rate of change of frames in an animation is called frame rate. It is measured in frames 

per second (fps). 

Graphics Tablet: This is a device used to draw sketches. 

Pixel: The smallest undivisible portion of an image is called pixel. 

Raster: Rastering is the projections of various pixels on CRT screen to form an image. 

Rotoscoping: Creation and manipulation of background images of an animation is called rotoscoping. 

This can be done manually as well as using computer software. 

Title Cards: Title cards are also called FIR of an animation. Title cards give brief information about the 

animation. 

Tween: The transition of one frame to another in animation is called tween. 

Vector: Some of the artwork is created by vectors rather than pixels. This allows cleaner and smoother 

animation because images are displayed by mathematical equation solutions. 

CEL: It is a cellulose sheet used to paint characters. In practice, it is now a day. plastic sheet in 

combination with the outline and coloring of a character, object, and/or special effect. 

 

 

 

Exercise-1  

Discuss the role of Media & Entertainment sector in India economy. 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 



 

 
 
 

Housekeeping Attendant (Manual Cleaning) 

9 

Color Key Artist 

 

Exercise-2 

Discuss the employability of various sub-sectors in Media & Entertainment Sector. 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 
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UNIT 1.2: Duties and Responsibilities of Color Key Artist 

 

Unit Objectives 

At the end of this unit, you will be able to:  

1. Learn about the role of Color Key Artist in industry. 

2. Identify the minimum requirement to become a certified Color Key Artist. 

3. Describe the work area of Color Key Artist. 

4. Identify the opportunities available for Color Key Artist. 

 

 

1.2.1 Introduction to Color Key Artist Job Role 

Colour key artist in the Media & Entertainment Industry is also known as the Background color key 

artist/ Character color key artist. Individuals at this job need to conceptualize the colour keys for all 

elements within a production. 

 

Figure 1.2.1 Work of a color key artist 

This job requires the individual to have a good knowledge of colour theory, light and shadows. The 

individual must know how to draw and apply colour effects. The individual must be able to design 

colour keys consistent with the creative style of the production using software such as Adobe 

Photoshop. 
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The job of a color key artist is one of the technically skilled jobs in animation industry. Color key 

artists develop color schemes in animations, they paint and style animation backgrounds, and work 

with technical administrators on light rigging. 

Color key artists produce color schemes that are acceptable for various lighting situations like “at 

night’ or “underwater.” Color key artists work primarily within the animation and game style 

industries. 

 

1.2.2 Job Profile of Color Key Artist 

A Color Key Artist performs following tasks in the industry: 

• Understand the artistic and communication goals of the script, brief or storyboard with 

respect to the individual’s role 

• Be aware of the intended medium and target audience, and how this may affect animation 

processes 

• Understand the aspects related to the design brief (appearance, complexion, dressing, 

moods, personalities, expressions etc.) 

• Understand the requirements according to the scripts (number, types, duplicates etc.) based 

on the individual’s role and its requirements 

• Understand the specifications for the background and other aspects (dimensions, operating 

parameters etc.) based on the individual’s role and its requirements 

• Add colour to line drawings in accordance with the colour keys established, under 

supervision 

• Check that the colour keys picked out and added to the drawings match the production 

requirements 

• Ensure consistency amongst all the characters 

• Ensure that the colour keys match the production requirements 

• Scan the artwork to make sure it matches the technical standards 

• Ensure that the digital images match the production references 

• Resolve problems as and when they arise without delay to make sure that disruption in the 

production chain is minimized 

• Respond positively to feedback and any changes in creative requirements 

• Coordinate with logistics players, where required, to have the equipment dispatched to the 

vendor/own facilities as required 

• Identify the people responsible for health and safety in the workplace, including those to 

contact in case of an emergency. 

• Identify security signals e.g. fire alarms and places such as staircases, fire warden stations, 

first aid and medical rooms. 

• Ensure own personal health and safety, and that of others in the workplace though 

precautionary measures 
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1.2.3 Opportunities for Color Key Artists 
There are various opportunities for assistant cameraman in the field of production houses and 

creative boutiques on projects. The main role of an assistant cameraman is to support cameraman 

in various tasks like setting focus length of camera, availing lenses, marking floor and so on. An 

assistant cameraman has following benefits for career aspect: 

 

• Medium range of salary with low educational investment 

• Opportunities in Movie production houses, news networks, and animation industry 

• Lots of opportunities to grow in the industry. 

 

1.2.4 Key Professional Skills 

This job requires the individual to have a good understanding of the colors and their interaction with 

scenario. The individual must know the fundamentals of colors and should possess good drawing 

and illustration skills. The individual must have a good working knowledge of color keying software 

like Illustrator, Photoshop etc. 

 

Exercise 

• Who is a Color Keying Artist? 

 

• What are the common industries where color keying artists find job? 

 

 

 

• Discuss the job responsibilities of a color keying artist. 
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Notes 
__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 
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Unit 2.1 – Principle of Animation 

Unit 2.2 – Understanding the Script 

 

MES/N0501 

2. Understanding the 

Script 
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Key Learning Outcomes 

At the end of this module, you will be able to: 

1. Understand the artistic and communication goals of the script, brief or storyboard with 

respect to the individual’s role 

2. Be aware of the intended medium and target audience, and how this may affect animation 

processes 

3. Understand the aspects related to the design brief (appearance, complexion, dressing, 

moods, personalities, expressions etc.) 

4. Understand the specifications for the background and other aspects (dimensions, operating 

parameters etc.) based on the individual’s role and its requirements 

5. Understand the technical needs of the project with respect to the job role (Television, Film, 

Gaming, Internet, DVD etc.) 

6. Understand the of the concept, which may be self-created, provided in a brief, or arrived at 

via discussions with relevant personnel (Director, Executive Producer etc.) 

7. Understand the requirements according to the scripts (number, types, duplicates etc.) based 

on the individual’s role and its requirements. 
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UNIT 2.1: Principle of Animation 

 

Unit Objectives 

At the end of this unit, you will be able to:  

1. Understand the artistic and communication goals of the script, brief or storyboard with 

respect to the individual’s role 

2. Be aware of the intended medium and target audience, and how this may affect animation 

processes 

3. Understand the aspects related to the design brief (appearance, complexion, dressing, 

moods, personalities, expressions etc.) 

4. Understand the specifications for the background and other aspects (dimensions, operating 

parameters etc.) based on the individual’s role and its requirements 

5. Understand the technical needs of the project with respect to the job role (Television, Film, 

Gaming, Internet, DVD etc.) 

6. Understand the of the concept, which may be self-created, provided in a brief, or arrived at 

via discussions with relevant personnel (Director, Executive Producer etc.) 

2.1.1 Animation and its types 

Animation is an optical illusion in which multiple static images are presented in front of eyes in such 

a way that they express motion and form a video clip. Animation can be classified into four 

categories: 

2.1.1.1 Simple Animation 

In simple animation no computer or electronic devices are used for optical illusion. We use hands to 

physically manipulate objects to perform this task. In this category of animation, we use different 

type of devices and methods that provide optical illusion like zoetrope, flipbook, chuckimation, 

pixilation and so on. In Zoetrope, multiple static images are pasted on a round wheel. While looking 

at one spot in zoetrope if you rotate the wheel then it forms an illusion of moving objects. 

 

Figure 2.1. 1 Zoetrope 
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In Flipbook, each page of the book has an image in continuation with previous image. When you flip 

the pages of book quickly, it create an illusion of moving objects. 

 
Figure 2.1. 2 Flipbook 

In chuckimation, we place a recording camera at a fixed spot and record the movement of objects. 

We record object for a few seconds at its position, then pause the recording and move the object 

slightly by hand, and record again for a few seconds while keeping the hand movement hidden from 

camera. Lego animations are performed by this method. This method of camera recording is called 

stop-motion or off camera hand movement. In Pixilation, movement of people is recorded in the 

same way as in chuckimation. 

 
Figure 2.1. 3 Chuckimation 

 
Figure 2.1. 4 Pixilation 
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2.1.1.2 Traditional Animation 
In Traditional animation, we use hand drawn pictures or cel (taken from celluloid sheet) animations. 

In this animation, thousands of pictures are drawn by hand on cels or acetate sheets and then each 

cel is photographed. In a video clip, each frame uses a photograph of cel. When played together, 

they produce an animation.  

 
Figure 2.1. 5 Cel Animation 

2.1.1.3 Computer Animation 
Computer animation consists of a wide variety of animations techniques like 2D Digital animation, 

3D Digital animation, motion capture, and so on. In 2D Digital animation, various software like After 

Effects, TV Paint, Cel Action and so on. In 2D animation, layers are used to build up background, 

landscape, character, and objects. Although 2D animation is not popular for artistic purpose 

anymore but it is still very popular for advertisements and desktop publishing.  

 
Figure 2.1. 6 2D animation 

3D animations use software like Maya, 3Ds Max, Blender, Cinema 4D, and so on. In 3D animation, 

simple models of character and objects are created by using 3D modeling tools and then textures 

are applied to give them realistic look. We use various motion tools and effects to perform motion 

of characters in the animation. 
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Figure 2.1. 7 3D Animation 

2.1.2 Principles of Animation 

There are 12 principles of animation first introduced by Disney animators Ollie Johnston and Frank 

Thomas. These principles are discussed next. 

Squash and Stretch 

The squash and stretch principle explains how objects should transform during motion. It says that 

moving objects should not be rigid. They should be displayed as flexible during motion. This principle 

is also applied on facial expressions.  

 
Figure 2.1. 8 Squash and Stretch Principle application 

Anticipation 

Anticipation principle is referred as preparation for motion. Whenever an objects performs motion 

in animation, it should have a few frames which display preparation of motion so that the viewer 

knows in advance that there is going to be a movement in the object/character. For example, if you 

want to display jump movement in the character then your character should move back and bend 

his/her knees. 
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Figure 2.1. 9 Anticipation Principle example 

Staging 

Staging principle defines the presentation of story through character. The pose of character and its 

actions should clearly present the mood, attitude and its need in the animation based on story. 

According to this principle, the background should also match the story line. 

 
Figure 2.1. 10 Staging Principle Example 

Straight Ahead Action and Pose to Pose 

Straight Ahead Action is half part of this principle which defines how animation progresses from first 

drawing. In simple animations where pose of character do not matter much for storyline, the 

animators keep on animating from first drawing. The animation is created frame by frame from 

beginning to end as per this principle. 

 

Figure 2.1. 11 Straight Ahead Action Principle 
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Pose to Pose principle is applied on animations where pose of character matters for the story line. 

As per this principle, key frames are created first and then intermediate frames of animation are 

created.  

 
Figure 2.1. 12 Pose to Pose Animation Principle 

Follow through and overlapping action 

As per this principle, when a character stops suddenly in animation then its body parts should not 

stop suddenly. They should catch up slower as compared to character. Like hairs of character should 

swing before coming to stop. When character suddenly changes direction then there should be an 

overlapping of cloths and other body parts before they change direction. 

 
Figure 2.1. 13 Follow through and overlapping action principle example 

Slow-in and Slow-out  

This principle defines how extreme actions should start and end. As per this principle, whenever you 

need to display realistic actions in an animation, you should create more frames at the starting and 

end of action. In this way, the character will have enough frames for acceleration before action and 

enough frames for stopping the action. 
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Figure 2.1. 14 Slow-in and Slow-out Principle example 

Arcs 

Most of the human, animal, and human-like characters follow arcs for their body motions. For 

example, hands and legs of characters almost always follow arc motion. 

 
Figure 2.1. 15 Arc animation principle example 

Secondary Action 

Secondary action is used to complement main action of character/object. For example, a character 

is walking down the street and moving his fingers on forehead then finger movement is a secondary 

action. 

 
Figure 2.1. 16 Secondary Action Principle example 
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Timing 

Timing principle defines various characters of the object/model. It defines the speed, weight, size, 

scale, and emotional state of character/object. Two same objects are falling from same height but 

we can make one object heavier just by manipulating timing. You can make object move slower by 

giving more frames to it in clip and similarly, you can make object move faster by giving lesser 

frames to it in the clip. In next image, same ball is hit by hammer but due to timing manipulation, 

one will appear heavy and other will appear lighter. 

 
Figure 2.1. 17 Timing Principle example 

Exaggeration 

Exaggeration means giving more power to face expressions, body movements, and actions of the 

character. If you remove exaggeration principle from an animation then what you get will be 

mechanical and stiff movements of character. Exaggeration is applied to give extra effects to 

common expressions. 

 

Figure 2.1. 18 Exaggeration Principle example 

Solid Drawing 

As per this principle, you should draw the characters keeping in mind that world works in 3 

Dimension and so should your character too. You should keep in mind that those characters whose 
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left and right sides are mirror images, do not look appealing in animation. Although there is less 

work left after introduction of computers but you will still benefit by knowing the basics of this 

animation principle. 

 

Figure 2.1. 19 Solid Drawing Principle 

Appeal 

Appeal is the most important and most decisive factor for success of animation. If your character is 

appealing then most of the flaws in character are ignored by the audience. It is not necessary that 

only hero or good character should be appealing in animation, villains and monsters should also be 

equally appealing for success of animation. 

 

Figure 2.1. 20 Appeal Principle 
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UNIT 2.2: Understanding the Script 

 

Unit Objectives 

At the end of this unit, you will be able to:  

1. Understand the artistic and communication goals of the script, brief or storyboard with 

respect to the individual’s role 

2. Be aware of the intended medium and target audience, and how this may affect animation 

processes 

3. Understand the aspects related to the design brief (appearance, complexion, dressing, 

moods, personalities, expressions etc.) 

4. Understand the specifications for the background and other aspects (dimensions, operating 

parameters etc.) based on the individual’s role and its requirements 

5. Understand the technical needs of the project with respect to the job role (Television, Film, 

Gaming, Internet, DVD etc.) 

6. Understand the of the concept, which may be self-created, provided in a brief, or arrived at 

via discussions with relevant personnel (Director, Executive Producer etc.) 

7. Understand the requirements according to the scripts (number, types, duplicates etc.) based 

on the individual’s role and its requirements. 

2.2.1 Animation Scripts 

An animation script is the step by step narration of what will happen in the animation, how will it 

happen and who will do what in the animation. The script also tells about actions, movements, 

expressions and dialogues of characters. Following are some key points of an animation script: 

• The script is formatted in such a way that one page of script is equal to approximately 1 to 

1½ minute of screen play. 

• The most common font used for scripts is Courier Normal with 12 point font size and 10 

point pitch. 

• Each script begins with Slug line. The slug line defines the location of scene, time of shoot, 

and type of shoot (Interior or Exterior). Slug line is like heading of a chapter. 

• Major components of script are actions and dialogues. Actions are always written in present 

tense. 

• Actions are also described with equipment settings, character movements, and sound 

effects or visual effects. 

• Dialogues are written in center column of script. 
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Figure 2.1. 21 Example of script 

2.2.1.1 Physical Format of Scripts 

In US, letter size paper is used to print scripts. Printing is single-sided on a three-hole punched 

paper. The top and bottom holes are held by two brass brads while the middle hole is left free for 

easy navigation.  

In UK, A4 size paper is used to print scripts. The paper is punched at two places top and bottom. 

Printing is done on one side of paper. Only the top hole is braded making it easy to flip the pages. 

2.2.1.2 Overview of Animation Script to Final Product 

1. Script defines the story of animation including description of character and surroundings. It 

includes actions and dialogues as discussed earlier. Television animations take all the factor 

in script and layout every fine detail of story. When the script is finalized, the work of 

storyboarding begins. 

2. Storyboard is visual representation of the script. Various thumbnails and drawings are 

created along-side the dialogues and actions of the script. It also defines camera movements 

with symbols during actions and dialogues. Once a storyboard is completed, the script gets 

limited to only dialogue recording, otherwise the crew refers to storyboard only. 



 
 

    
 
 

Participant Handbook 

28 

 
Figure 2.1. 22 Storyboard 

3. During the storyboarding, character casting is performed in parallel based on the script. 

 
Figure 2.1. 23 Character Casting 

4. After the completion of storyboarding, the work of designing begins. Various objects like 

background, character, vehicles, and so on are designed based on storyboard. 

 
Figure 2.1. 24 Character Designing 

5. After completion of storyboarding, the recording of dialogues begin immediately. Once the 

dialogues of a section of script are recorded, they are sent to design team which creates 

animation matching to the dialogues. 
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Figure 2.1. 25 Dialogue recording 

6. Layout processes begins after storyboarding and in parallel to other design works. In this 

step, movements of character are defined in references to background, foreground, other 

character and objects. 

 
Figure 2.1. 26 Layout designing 

7. Based on the requirement, 2D or 3D animation is performed using animation techniques 

discussed earlier.  
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Figure 2.1. 27 2D and 3D animation 

8. Once the animation is produced, the post production phase of animation starts. In this step, 

video is edited for its final form. Music tracks and sound effects are applied to the clip.  

Various color corrections are performed to make a seamless view experience. 

 
Figure 2.1. 28 Post Production Editing 

2.2.2 Reading A Script 

Following are the steps involved in reading a script of animation: 

Getting familiar with formatting 

Screenplays and scripts are written in a different way from books and other contents. Knowing the 

format is important to understand the script. As discussed earlier, the slugline is one line description 

at the top in every scene. The slugline defines location, time and type of scene. If a character 

appears first time in the scene then his/her name will be written in all capital letters. Name of 

character is written before his/her dialogue in the script. All the dialogues are centered. There 

should be an action line before dialogue defining the state of character who will be delivering the 

dialog. 
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Figure 2.1. 29 Script Formatting 

Finding Act Breaks 

Most of the scripts are divided into three acts.  

• The first act introduces the character and defines the world in which character lives. It also 

lays down the framework of what is going to happen in the story. Generally first act takes 

around 30 pages in the script. 

• The second act expands the journey of character. In this act, the character will go through 

various difficult situations and conflicts. During this act, character will try to find something 

and at the end of this act, the character will be having clear view of his/her goal. This act 

takes approximately 60 pages of the script. 

• The third act ends the journey of character. In this act, the character will have final 

confrontation and achieve the final goal. This act takes approximately 30 pages of the script. 

 
Figure 2.1. 30 Act chart 

Check the Character Arc in script 

Check the script from start to end while keeping an eye on the development of character. Note that 

a character develops throughout the script and character may change goal during the story. The 

color key artist need to match the mood of character and its background throughout the whole clip.  

Reading Script Analytically 

While reading the script, following points should be kept in mind: 

• Read the script in a quiet place with open mind. 
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Figure 2.1. 31 Reading in quiet place 

• Read the script in such a way that you are not analyzing the script but reading the script to 

enjoy it. 

 
Figure 2.1. 32 Reading to enjoy script 

• Write down all the observations in the form of notes while reading the script and return to 

them after you have finished reading. 
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Figure 2.1. 33 Note down your observations 

• Do not take frequent breaks while reading the script otherwise you will lose the story. 

 
Figure 2.1. 34 No frequent breaks 

• Always try to read script from a hard copy. 

 

Figure 2.1. 35 Take a printout 
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• Once you have read the script till end one time, then get back at the beginning and read the 

script scene by scene. Note down the key areas of script related to your job in every scene. 

• Be aware of the intended medium and target audience, and how this may affect animation 

processes 

• Understand the aspects related to the design brief (appearance, complexion, dressing, 

moods, personalities, expressions etc.) 

• Understand the requirements according to the scripts (number, types, duplicates etc.) based 

on the individual’s role and its requirements 

• Understand the specifications for the background and other aspects (dimensions, operating 

parameters etc.) based on the individual’s role and its requirements 

• Understand the of the concept, which may be self-created, provided in a brief, or arrived at 

via discussions with relevant personnel (Director, Executive Producer etc.) 

2.2.3 Copyright Norms for Scripts  

Copyright is right given by the law to creators of literary, dramatic, musical and artistic works and 

producers of cinematograph films and sound recordings. In fact, it is a bundle of rights including, 

inter alia, rights of reproduction, communication to the public, adaptation and translation of the 

work. Copyright ensures certain minimum safeguards of the rights of authors over their creations, 

thereby protecting and rewarding creativity. In India, copyright protection is available in following 

three categories: 

• Original literary, dramatic, musical and artistic works 

• Cinematograph films 

• Sound recordings 

An animation or movie script falls in the first category. You can file a copyright request by visiting 

the Copyright Office in Delhi (Boudhik Sampada Bhawan, Plot No. 32, Sector 14, Dwarka, New Delhi-

110078) or by visiting their website http://copyright.gov.in. There is a very nominal fee of 500 rupee 

for script copyright registration. 

 

 

 

 

 

 

 
 



 

 
 
 

Housekeeping Attendant (Manual Cleaning) 

35 

Color Key Artist 

Notes 
__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

    
 
 

Participant Handbook 

36 

Exercise  
1. What is animation and what are its types? 

 

 

 

 

 

  

2. Discuss the Squash and Stretch principle of animation. 

 

 

 

 

 

3. Discuss the staging principle of animation. 

 

 

 

 

 

4. Discuss the Straight Ahead Action and Pose to Pose principle of animation. 
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5. Write down an overview of animation in steps. 

 

 

 

 

 

6. Discuss the key points to be noted while analyzing the script. 
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Key Learning Outcomes 

At the end of this module, you will be able to: 

1. Interpreting the requirements of the script to understand the color keys required with 
respect to the individual’s job role. 

2. Maintaining consistency across all production elements. 
3. Add color to line drawings in accordance with the color keys established, under supervision. 
4. Check that the color keys picked out and added to the drawings match the production 

requirements. 
5. Ensure consistency amongst all the characters. 
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UNIT 3.1: Introduction to Color Keying 

 

Unit Objectives 

At the end of this unit, you will be able to:  

1. Interpreting the requirements of the script to understand the color keys required with 
respect to the individual’s job role. 

2. Maintaining consistency across all production elements. 
3. Add color to line drawings in accordance with the color keys established, under supervision. 
4. Check that the color keys picked out and added to the drawings match the production 

requirements. 
5. Ensure consistency amongst all the characters. 

 
 

3.1.1 Introduction 

Color keying is the process of adding or replacing character colors, background colors, lighting, and 

shadows. Color keying is also needed to color line drawings and edges of characters in animations. 

Before we go deeper into work area of color keying artist, it is important to understand few basic 

concepts related to color keying. 

 

3.1.2 Principles of Color Theory 

Color theory guide us in practical mixing of colors and probable outcome of this mixing. It also 

describes the visual effects of certain color combination in the image/video. Although there are 

many theories put by different people at their time but they all reach at a same point when it comes 

to color mixing and contrast. We use Color Wheel developed by Sir Isaac Newton to understand and 

apply different combinations of colors. 

The basic color wheel has 12 sections of different colors. These colors can be combined to produce 

colors with different properties. 
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Figure 3.1. 1 Color Wheel 

 
The wheel is divided into two main categories; Warm colors and Cool colors. Warm colors are 

associated with sun or fire. Cool colors are associated with water or grass. Colors like red, yellow and 

orange are warm colors while colors like blue green and purple are cool colors.  

Primary Colors 

The Red, Yellow and Blue colors are called primary colors (Pure colors) as they cannot be produced 

by mixing other colors but you can use these three colors to produce any other color. 

 
Figure 3.1. 2 Primary Colors 

Secondary Colors 

Secondary colors are made by mixing two primary colors. Orange, green and violet are secondary 

colors. 
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Figure 3.1. 3 Secondary Colors 

Tertiary Colors 

Tertiary color is made by mixing one primary color with other adjacent secondary color. Colors that 

are adjacent to each other are called analogous colors. The example of tertiary colors are red-

orange, blue-green, and so on. 

 
Figure 3.1. 4 Tertiary Colors 

Complementary Colors 

The complementary colors are those which cancel out each other’s hues and produce achromatic 

(white, gray, or black) color mixture. These colors are generally opposite to each other in color 

wheel. 
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Figure 3.1. 5 Complementary colors 

3.1.2.1 Color Selection 

Color selection is a tricky job for artist. There are some many combinations of colors that can work 

based on your scene but it is the job of a good artist to decide best color combination. Following are 

some of the points to be kept in mind while selecting color. 

• Selection of color for main character depends on the mood and role of character. Blue-

green color is associated with cool, red color is associated with passion, yellow-green color 

is associated with growth, and yellow-orange color is associated with warmth. You can 

select a color matching the character’s role. 

• After selecting color for lead character, the next step is selecting color for supporting roles 

which can complement the lead character. If you want to express unity of supporting roles 

or surrounding with the lead character then you should use analogous color of your main 

character’s color. For example, if your lead character is blue then you can use cyan color to 

express unity. 

• If you want each character in your animation to have its own aroma then you should use 

different primary or secondary colors for them. 

3.1.3 Lighting and Color Temperature 

Lighting is an important part of movie making. Lighting has the power to change mood of scene 

directly which is why lighting department is always in direct control of director of photography. 

Lighting color is measured in K (kelvin) unit which is also the unit of temperature. Hence, we say 

color temperature instead of lighting color. The lower the K value, the more the redness in color. 

The next figure shows a color chart of common light sources by temperature. 
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Figure 3.1. 6 Color Chart 

These temperature properties are copied in creating different light bulbs.  

 
Figure 3.1. 7 Color of bulbs by temperature 

Various types of light equipment used in studios are discussed next. 

Tungsten Light 

Tungsten lights are similar to common household bulbs but with much more power. They produce 

an orange hue. You can adjust to intensity of tungsten lights. These lights are dimmable as needed. 

Tungsten lights are generally used for interior lighting. You can add blue gel in tungsten light to 

produce daylight effect. 

 
Figure 3.1. 8 Tungsten Light 

Hydrargyrum Medium-Arc Iodide (HMI) Light 

HMI are the most used lights in a studio. HMI lights produce ultraviolet light with blue hue. For the 

first few hours, the temperature of light is around 15000 K and as the light settles to optimum 

range, the temperature goes back to 5600 K which is closer to daylight. The bulb can be dimmed up 

to 50% of its capacity creating a stronger blue hue. This is one of the expensive light equipment. 
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Figure 3.1. 9 HMI Light 

Fluorescent Light 

You can set the color temperature of fluorescent lights from 2700K to 6500K. The temperature of 

light depends on mixture of phosphorus content in the bulb. These lights are compact, light-weight 

and much cooler than other light options. 

 
Figure 3.1. 10 Fluorescent Light 

LED Light 

Light Emitting Diode (LED) are the latest trend in lighting. LEDs can be manufactured for almost 

every color and you can produce directional light using them. LEDs can produce only single 

wavelength of light and hence to produce a white light, you will need combination three LEDs (Red, 

Green and Blue). LEDs can produce constant intensity lights. 

 
Figure 3.1. 11 LED light 
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Sun 

This is something you cannot create in labs or factories. Sun is the natural and free source to 

produce perfect daylight if weather is clear.  

 
Figure 3.1. 12 Sun Light 

 3.1.4 Traditional Animation and Coloring Approach 

Traditional animation is the type in which animator draws everything by hand on paper. An 

animator first draws background and other fixed assets of animation on papers and then transfer 

them on cel slides. Then, animator draws multiple slides of characters with their slight movements 

as per the story on cel slides. During the animation, these slides are produced in multiple layers one 

after another creating an illusion of movement. Although this technique is outdated in digital era 

but still there are times when computer is not able to represent the imagination of animator. In such 

cases, animator uses the traditional approach to produce slides but do not color them. Instead, after 

creating the line sketches of characters, the animator transfers them to computer where they are 

colored. This approach is a mix of traditional and digital approach producing remarkable results. 

The traditional approach is divided into three major steps: 

• Cleaning 

• Inking 

• Painting 

These steps are discussed next. 

3.1.4.1 Cleaning 

After creating rough frames of animation on paper, the next step is to remove extra marks and 

geometries.  
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Figure 3.1. 13 Rough Sketch 

 
Figure 3.1. 14 Clean Sketch 

3.1.4.2 Inking 

Inking is the process of transferring sketches onto cel sheets. While keeping the paper sketch below 

cel sheets, an artist traces the sketch with permanent marker. Although most inking is done by hand 

but sometimes, you can use photocopy machine to replicate sketch faster. 

 
Figure 3.1. 15 Inking process 
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3.1.4.3 Coloring/Painting 
In this step, the outlines created on cel sheet are filled with different colors. Before beginning the 

coloring of sketch, the artist decides different colors of sketch and then prepare the color palette. 

Once the colors are decided and palette is prepared, it is the art level of artist to create drawing. 

 
Figure 3.1. 16 Painting 
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UNIT 3.2: Color Keying with Photoshop 

 

Unit Objectives 

At the end of this unit, you will be able to:  

1. Interpreting the requirements of the script to understand the color keys required with 
respect to the individual’s job role. 

2. Maintaining consistency across all production elements. 
3. Add color to line drawings in accordance with the color keys established, under supervision. 
4. Check that the color keys picked out and added to the drawings match the production 

requirements. 
5. Ensure consistency amongst all the characters. 

 

 

3.2.1 Introduction to Photoshop 
Photoshop is a software by Adobe Inc. This is a raster graphic design software used to create and 

edit image files. You can edit and create images in multiple layers as you do in by hand animation. 

You can perform masking and alpha compositing by using this software. Various colors schemes 

available in Photoshop are RGD, CMYK, duotone, CIELAB, and Spot Color. You can also use expanded 

features by using plug-ins. The native file format of Photoshop is .PSD. 

 

3.2.1.1 Interface of Adobe Photoshop 

 
Figure 3.2. 1 Photoshop Interface 
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Document Window 

The document window is area inside the application where all the images are displayed and edited. 

The area in document window where image file is displayed is called canvas. The dark area around 

the canvas is called pasteboard. The pasteboard does not serve any function in output but you can 

use it for placing small objects during editing. Once the editing is finished, you need to remove all 

the objects in the pasteboard. 

 
Figure 3.2. 2 Document Window 

Document Tab 

The document tab is displayed when a file is open in Photoshop. The document tab give name of 

file, format of the file, and current zoom level of canvas. If there are more than one document open 

then you can use the respective tab to open the document. 

 
Figure 3.2. 3 Document tab 

 Status Bar 

The Status bar is available below the pasteboard. The status bar gives various notifications and 

modification options like zoom level, color profile of image, information related to image size and so 

on. 
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Figure 3.2. 4 Status Bar 

Toolbar 

The toolbar contains all the tools to perform selection, creation, and editing of images. There are 

also tools available to create different objects. The toolbar is available at the left in the interface. 

 
Figure 3.2. 5 Toolbar 

You can expand the toolbar by clicking on the double arrow at the top in the toolbar. 
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Figure 3.2. 6 Expanded Toolbar 

You will find small arrow at the bottom of some of the tools which signifies that there are more 

tools similar to that tool. All the tools that function similar are grouped together. 

 
Figure 3.2. 7 Hidden Tools 

Options Bar 

The Options Bar displays options related to current selected tool or object. The Options Bar is 

available above the Document Tabs. 

 
Figure 3.2. 8 Options Bar 
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Menu Bar 

Menu Bar is available at the top in the interface. There are various menus available in the Menu bar. 

Each menu contains tools and options of similar functioning. For example, File menu contains tools 

for handling files.  

 
Figure 3.2. 9 Menu Bar 

Panels 

Panels are available at the right in the application window. Panels contain various settings for 

selected objects. The most common used panel is Layer panel. This panel is used to create, delete, 

and modify layers. 

 
Figure 3.2. 10 Panels 

To option desired panel, click on the respective tile from the Panels area. To display more panels, 

select the respective option from the Window menu in the Menu Bar. 

 
Figure 3.2. 11 More panels in Window menu 
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Search Bar 

The Search Bar is used to find tools and commands available in Photoshop. You can also use search 

bar to get help and hints of a tool. 

 
Figure 3.2. 12 Search Bar 

Workspace 

Workspace is a master setting of the software used to define how you want to use this software. 

Workspace controls the display and position of tools, panels, menus, keyboard shortcuts, and so on. 

 
Figure 3.2. 13 Workspace 

3.2.2 Basic Operations in Photoshop 

Before we move on to the tools related to coloring, it is important to understand the basic 

operations like starting a new file, opening a file, closing the file and so on. These operations are 

discussed next. 

3.2.2.1 Starting a New File in Photoshop 

• Start Photoshop by clicking on the icon from the desktop or Start menu. 

• Click on the New button from the File menu or press CTRL+N. The New dialog box will be 

displayed. 
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Figure 3.2. 14 New tool 

 
Figure 3.2. 15 New dialog box 

• Specify the desired name in the Name edit box. 

• Select the desired option from the Preset drop-down to define the type of document. You 

can also set the parameters in edit boxes below it to create a document with custom 

settings. 

• Expand the Advanced options to select the desired color profile and aspect ratio from the 

respective drop-down. 

• If you want to save the current profile then click on the Save Preset button from the dialog 

box and save it at desired location. 

• Click on the OK button from the dialog box to create the new document. 
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Figure 3.2. 16 New Document in Photoshop 

3.2.2.2 Opening a Document 

• Click on the Open button from the File menu. The Open dialog box will be displayed. 

 
Figure 3.2. 17 Open tool 
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Figure 3.2. 18 Open dialog box 

• Select the desired file from the dialog box and click on the Open button. The selected 

document will be displayed in Adobe Photoshop. 

3.2.2.3 Saving File 

• After performing editing of file. Click on the Save button from the File menu or press 

CTRL+S. If you are saving the file for first time then Save As dialog box will be displayed. You 

can access this dialog box by using Save As tool in the File menu. 

 
Figure 3.2. 19 Save As dialog box 
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• Specify the desired name of file in File name edit box. You can change the format of file 

from the Format drop-down. 

• Set the other parameters as desired and click on the Save button. 

3.2.2.4 Closing Document(s) 

• Click on the Close button from the File menu to close current document. You can also close 

the document by click on the close button on respective Document tab. 

 
Figure 3.2. 20 Close Tool 

• Click on the Close All tool from the File menu to close all the documents which are open in 

Photoshop. 

3.2.2.5 Importing Video Frames 

• Click on the Video Frames to Layers option from the Import cascading menu of the File 

menu. The Open dialog box will be displayed. 

 
Figure 3.2. 21 Video Frames to Layers 
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• Select the desired video clip from the dialog box and click on the Open button. The Import 

Video to Layers dialog box will be displayed. 

 
Figure 3.2. 22 Import Video To Layers dialog box 

• Set the desired range and parameters in the dialog box. Click on the OK button from the 

dialog box. The layers will be created in a new file. 

3.2.2.6 Exporting Video 

• After creating multiple layers of images in Photoshop, click on the Render Video tool from 

the Export cascading menu of the File menu. The Render Video dialog box will be displayed. 

 
Figure 3.2. 23 Render Video tool 
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Figure 3.2. 24 Render Video dialog box 

• Specify the name of file in Name edit box.  

• Click on the Select Folder button and set the desired location where you want to save the 

file. 

• Set the desired parameters in the dialog box and click on the OK button to create the video. 

3.2.3 Color Keying in Photoshop 

There are various operations that can be performed in Photoshop related to color keying like 

removing background, change colors of specific portions of image, selective color effect, cutout of 

images, and so on. Some of the major operations are given next. 

3.2.3.1 Removing Green Screen Background (Chroma-

keying) 

• Create a copy of the image file whose background is to be removed.  

• Open the copy of main image file in Adobe Photoshop. 

• Double-click on the Background layer available in the Layers panel. The New Layer dialog 

box will be displayed.  
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Figure 3.2. 25 Background layer 

 
Figure 3.2. 26 New Layer dialog box 

• Set the desired name of layer and click on the OK button from the dialog box. 

• Click on the Color Range tool from the Select menu in Menubar. The Color Range dialog box 

will be displayed. 

 
Figure 3.2. 27 Color Range dialog box 

• Click on the Eyedropper tool and click in the green region as shown in next figure. 
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Figure 3.2. 28 Selecting color 

• Check the preview of image in the dialog box. It should display white background with black 

objects. Click on the OK button from the dialog box. 

• Click on the Inverse tool from Selection drop-down. Your objects will get selected. 

 
Figure 3.2. 29 After Inverse Selection 

• Click on the Edit in Quick Mask Mode tool from the Select menu and set the desired value of 

colors to refine edges. Click again on the tool to exit the mode and set the rest of colors for 

edge in the Color panel. 
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Figure 3.2. 30 Setting Edge Colors 

• Click on the Inverse tool from the Select menu again and press Delete from keyboard. This 

will remove the background.  

 
Figure 3.2. 31 Image after removing background 

• Click on any of the Marquee tool and click in the empty area to deselect everything. 

 
Figure 3.2. 32 Marquee tools 

• Use the Eraser tool from the Toolbar and remove the extra marks left in the image. 

• Click on the Save As tool from the File menu. The Save As dialog box will be displayed. 
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• Save the file with PNG format. 

3.2.3.2 Applying Selective Black and White Effect to Image 

• Load the image on which you want to apply selective Black and White Effect. 

• Click on the Create New Fill or adjustment layer tool at the bottom in the Layers panel. A list 

of tools will be displayed. 

 
Figure 3.2. 33 New Fill menu 

• Click on the Black & White tool from the list. A new layer will be created and Properties 

panel will be displayed. 

• Drag the sliders to modify the black and white shade. Each color slider will lighten or darken 

the respective color in the image. You can also click on the Auto button in the panel to set 

color darkness automatically. 
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Figure 3.2. 34 Adjusting Black and White regions 

• Click on the Brush tool from the Toolbar and select a suitable size of brush with soft round 

properties. 

 
Figure 3.2. 35 Setting Brush properties 

• Click on the Set foreground color button and set the foreground color as black. Similarly, set 

the background color to white. 

 
Figure 3.2. 36 Setting colors 
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• Now, click the LMB on the area which you want to display in original color state and drag the 

mouse. 

 
Figure 3.2. 37 Painting original color 

 
Figure 3.2. 38 Final Image 

3.2.3.3 Photoshop Image Adjustment tools 

There are various tools available in Adjustments panel of Photoshop that you can use to color 

correct your image with simple drag operations. These tools are discussed next. 
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Figure 3.2. 39 Adjustments panel 

Brightness/Contrast Tool 

Click on the Brightness/Contrast tool to adjust the brightness and contrast of the image. 

 
Figure 3.2. 40 Brightness Adjustment 

Level Adjustment 

Click on the Level tool from the Adjustments panel to modify brightness level of image. Use the 

sliders to modify level of brightness. 

 
Figure 3.2. 41 Level adjustment 
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Curve Adjustment 

The Curve tool in Adjustments panel is used to perform tone adjustments. 

 
Figure 3.2. 42 Curve adjustments 

Exposure Adjustment 

The Exposure tool in Adjustments panel is used to set exposure of your image in the same way as 

you do with camera. This tool can be used to adjust exposure, offset and gamma level. 

 
Figure 3.2. 43 Exposure adjustment 

Vibrance Adjustment 

The Vibrance tool in Adjustment panel is used to define how sharp the colors should display. 
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Figure 3.2. 44 Vibrance Adjustment 

Hue/Saturation Adjustment 

The Hue/Saturation tool in Adjustments panel is used to modify the hue and saturation value of 

image file. 

 
Figure 3.2. 45 Hue/Saturation Adjustment 

Similarly, you can use other adjustment tools: 

• Color Balance 

• Black & White 

• Photo Filter 

• Channel Mixer 

• Color Lookup 

• Invert 

• Posterize 
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• Threshold 

• Selective Color 

• Gradient Map 

You can also apply various filter available in the Filter menu of Photoshop to adjust properties of 

image file. You can perform various operations like sharpen the image, add noise, distort, pixelate, 

render objects, and so on by using filter tools. 

 
Figure 3.2. 46 Filter menu 
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Exercise  
1. Discuss the color theory and importance of color wheel. 

  

 

 

 

 

  

2. Discuss the color selection method for animation. 

 

 

 

 

 

3. What is lighting and color temperature? 

 

 

 

 

 

4. Discuss the traditional coloring approach. 
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5. What is the function of Status Bar, Options Bar, Toolbar, and Menu Bar in Photoshop? 

 

 

 

 

 

 

 

6. Write the procedure of starting a new file in Photoshop. 

 

 

 

 

7. Write down the procedure of remove green screen background from an image. 

 

 

 

 

8. What is the use of Curve tool in Adjustments panel? 
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4. Quality Check 

Unit 4.1 – Quality Check 
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Key Learning Outcomes 

At the end of this module, you will be able to: 

1. Ensure that the colour keys match the production requirements 

2. Scan the artwork to make sure it matches the technical standards 

3. Ensure that the digital images match the production references 

4. Resolve problems as and when they arise without delay to make sure that disruption in the 

production chain is minimized 

5. Respond positively to feedback and any changes in creative requirements 
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UNIT 4.1: Quality Check 

 

Unit Objectives 

At the end of this unit, you will be able to:  

1. Ensure that the color keys match the production requirements 

2. Scan the artwork to make sure it matches the technical standards 

3. Ensure that the digital images match the production references 

4. Resolve problems as and when they arise without delay to make sure that disruption in the 

production chain is minimized 

5. Respond positively to feedback and any changes in creative requirements 

 

 

4.1.1 Common Quality Issues 

There are various common issues that are sometimes ignored at primary stage but can cause 

problems later. These issues are discussed next. 

4.1.1.1 Canvas Size Selection 

Canvas selection in software is an important decision. A large canvas for small image will induce 

more pixels and make the system process large data which is not necessary. If you select a smaller 

size canvas then you will be reducing the size of image and at the same time reducing the number of 

pixels. Check the difference below: 

 

Figure 4.1. 1 Effect of size and resolution 
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4.1.1.2 Background Selection 
You should always know the color combination in your image and select the background 

accordingly. Pure white or pure black backgrounds can lower the effect of image. The most neutral 

color is 50% gray with value #808080. 

 
Figure 4.1. 2 Change in brightness due to background 

4.1.1.3 Contrast Setting 
Contrast can amplify the beauty of image. If you are using a laptop for working on image then you 

will notice that you perceive different contrast at different angles. So, how will you know that the 

contrast setting is correct. In such situations, you should use the Level adjustment of Photoshop.  

 
Figure 4.1. 3 Effect of contrast settings 

4.1.1.4 Color Reference 
Sometimes, you may need to match colors of your object with surroundings. In such cases, you 

should not use color palette to match colors by values. You should rather use color pick tool to pick 

desired color from the image. 
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Figure 4.1. 4 Picking color from image 

4.1.1.5 Blending Edges 

It is important to blend edges in images. But you should know the softness in blend required by your 

image. The same value of softness cannot be applied everywhere for blending. The value of softness 

depends on hit and try method. Use a certain value of softness and if you do not get desired result 

then change it slightly up/down. Keep doing until you get the perfect blend of edges in image.  

 
Figure 4.1. 5 Blending 

4.1.2 Quality Checks 

1. Check whether the file generated is of correct format. 
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Figure 4.1. 6 Common formats of image files 

2. Check the resolution of image. 

 
Figure 4.1. 7 Resolution 

3. Check the sharpness, noise, distortion, uniformity and other modification factors are as 

desired. 

4. Check whether the color combination of main character, side-characters and background is 

proper. 

5. Check whether the edges of character perfectly blend with background if you have 

performed Chroma-keying. 
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Figure 4.1. 8 Chroma keying 

6. Make sure there is no left over in the image that should be removed. 

7. Check the level and lighting of image and make sure that it fits well with rest of the frames. 

8. Check the requirements given by the director and make sure everything is there in the file. 

9. Make sure the colors match with the art board provided to you. 
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Exercise  
1. Write down the steps for packing camera? 

  

 

 

 

 

  

2. Discuss the process of returning equipment to rental store? 
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5. Health & Safety 

Comply with Workplace 

Unit 5.1 – Safety, Health, and Hygiene 

Unit 5.2 – First Aid 
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Key Learning Outcomes 

At the end of this module, you will be able to: 

1. Observing and understand the current health, safety, security policiesa and procedure of 
organization.  

2. Understand the safe working practices pertaining to own occupation.  

3. Understand the government rules and policies related to the health and safety including 
emergency procedures for accidents, illness, fires or others.  

4. Identifying the person responsible for health and safety in the working area, including those 
person whom to contact in emergency.  

5. Identifying the security signals in the workplace fire alarms, staircases, fire warden stations, first 
aid and medical rooms.  

6. Identifying the possible work hazards in the working area which can cause risk to others health 
and safety.  

7. Ensuring own and others health and safety in the workplace through precautionary measures.  

8. Identify and recommend the basic terms and opportunities to the designated person of your 
workplace for improving health, safety, and security.  

9. Identify and correct the cause of accidents, illness, and fires in your working area and within the 
limits of individual’s authority.  
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UNIT 5.1: Maintain Workplace Health and Safety 

 

Unit Objectives 

At the end of this unit, you will be able to:  

1. Observing and understand the current health, safety, security policiesa and procedure of 
organization.  

2. Ensuring own and others health and safety in the workplace through precautionary 

measures.  

3. Identify and recommend the basic terms and opportunities to the designated person of 

your workplace for improving health, safety, and security.  
 

5.1.1 Introduction: 

Emergency evacuation is needed when staying within the building not safe anymore. Every 

organization has an evacuation procedure. Every organization has a safe place within the 

organization compound or outside the organization compound where all employees are expected to 

assemble in case of an emergency evacuation. The team leader guides the team and takes them to 

safe place. It is very important in these cases, to assemble at the safe area immediately.  

If you do not reach the safe area on time, the team leader who is responsible for your safety will 

send someone to look for you. This will put the other person's life in danger. 

Conditions for Evacuation  

Emergencies which require immediate evacuation includes:  
• Explosions  

• Fires  

• Earthquakes  

• Hurricanes  

• Floods  

• Workplace violence  

• Toxic material releases  

• Tornadoes  

• Civil disturbances  

 

Every company has:  
• An evacuation policy. All the TLs are responsible for informing their employees about it. 

When the TL is informing you about these details, pay attention. This negligence could cost 
lives.  

• A designated place for emergencies. Ensure that you know where it is.  
• A “buddy system” for individuals with special needs or disabilities. If you are a buddy to 

someone, ensure that your buddy is safely out of the premises with you.  
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Figure 5.1.1 Conditions for evacuation 

 
• Floor plans with evacuation routes in work areas. Ensure that you understand it so that you 

can use it in time of need.  
• Assembly areas. These are the areas where you are required to assemble after evacuation.  
• Periodic evacuation drills. Ensure that you pay attention during those drills. You need to 

save your life and you can be helpful in saving someone else’s life too.  
 

5.1.2 Mock Drills/ Evacuations 

The responsibility of the safety of the workers in case of emergency is on the fire safety and 

evacuation workers. These workers need to go through the training to know the duties and 

responsibilities. In a workplace, the practice drill should be done in every 3 months under simulated 

fire conditions so that the workers know the techniques of saving their and other life. By practicing 

in the fire drills, all the workers area able to know the lifesaving method required in case of 

emergency. 

Fare the exercises designed check the staff response as per emergency. It is also a test of the 

emergency staff, working staff and other members of fire safety department. Sometime the drill is 

not successful but that’s okay because human learn from previous mistakes. But it is important for 

all the members that they correct their mistake on time. Sometime all the mistakes were not done 

by the members of staff, the mistake is done the faulty equipment and safety plans. But, there is a 

need of staff training periodically. 
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Figure 5.1.2 Mock Drills 

There are two vital components for preparing the fire safety plan which are written below:  
1. An emergency action plan, which tells the procedure to be optimize in case of emergency.  

2. A fire prevention plan, which tells the methods to be optimize to cool the fire as soon as 
possible.  

 
You need to participant in arranged by organization for your personal safety and also for others 

safety. These drills help you in understanding the 

Fire safety and evacuation plans sketch staff duties and accountabilities in time of emergency. 
Continuing training is required to help safeguard that the employees are conscious of those duties 
and responsibilities. Firefighting trainings serve as an prospect for staff members to validate, under 
replicated fire conditions, that they can perform those duties and responsibilities safely and 
efficiently. It’s also a time for the workers or employee to demonstrate about the defend-in-place 
strategies and also the workers are able to take advantage of facility’s fire protection features and 
exit facilities to protect the people in their care.  

Fare excellent exercise designed to evaluate staff response to a replicated emergency. The fare is also 
a test of facility’s fire safety/evacuation strategies and staff training programs. It is not essential that 
all frun smoothly. That’s okay, so long as staff and the organization understand from them and correct 
mistakes made. It’s vital, therefore, that there be a analysis of each drill so that any problems met can 
be addressed. Perhaps the problems are due to unfinished or out-dated fire safety/emigration plans. 
Perhaps there’s a need for further training of staff.  

The two essential components of a fire preparedness plan are the following:  
1. An emergency action plan, which details what to do when a fire occurs.  
2. A fire prevention plan, which describes what to do to prevent a fire from occurring. 

 

5.1.3 Medical Emergencies 

Everyone plans for emergencies. That is the reason why we keep a first aid kit with ourselves. At 

work, however one is exposed to a lot of stress and physical activity. This could lead to certain 

medical emergencies. It’s better to be prepared with the first aid measures and knowledge of 

implementing them on ourselves and on others. This module equips you with that information. Pay 
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attention to these medical emergency procedures to understand how to conduct you in theses 

crucial movements. Pay attention during these sessions. You might be able to save your own and 

your friend lives. 

5.1.3.1 In case of Medical Emergency 

A medical emergency is a situation in which a worker met in accident and needs medical help. The 
medical injury may be severe or life threating. Some situation where:  

• Person is not inhaling  
• Heart attack or stock  
• Heavy or severe bleeding  
• Electric Shock  
• In case of Poisoning  
• Person get somebody Burns  

 

In case of medical emergency, the person or victim requires the immediate help. Sometime the person 
need attention before the you call the emergency helpline.  

It is important to know or remember the number of emergency helpline or Emergency Medical Service 
(EMS) for the safety of self and other workers.  

DON'T  
• Let the victim to eat or drink anything.  
• Confine the victim  
• splash any fluid on victim face or on injury.  
• shift the victim to another area or place unless it is the only way to protect the 

victim.  
 

Bleeding  
• Apply any type of pressure on the wound of victim with the help of bandage or any other 

means.  
• Elevate the wound to slow the bleeding.  
• When necessary, apply the pressure on pressure points near wound to block excess 

bleeding.  
 

Fainting  

 
• Fainting is a loss of consciousness which is due to temporary reduction flow of blood in the 

victim's brain.  
• The unconsciouness of the victim may led to more injury in the workplace.  
• Slow pulse of the victim.  
• The pale, cold skin and sweating of the victim.  

 

Causes of fainting:  
• Eating or drinking lack of fluids which is also known as dehydration. 
• The low blood pressure of victim. 
• Due to lack of sleep. 
• Over exhaustion of the worker 
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First Aid for Fainting:  
• Lie down the victim on the back and raise the legs above his heart level.  
• Ensure the clearance of victim's nose.  
• Check for indication of coughing, or breathing problem.  
• Loose the tight cloths like neck ties, collars, and belts.  
• If the victim remains unconscious from the 1 minute, call the EMS as soon as possible.  

 

Shock  

The shock occurs in the human body on the failure of circulatory system. When insufficient amount 
of oxygen is reached in the body tissue, the shocks also occur. This condition is treated as soon as 
possible if not, it may lead to organ failure, and may cause death. Shock becomes worse by fear and 
pain of victim.  

First Aid for shock:  
• If possible, keep the victims in lying down position.  
• Raise the legs 10-12 inches from the ground level unless you suspect a injury in back and 

bone.  
• If the victim is feeling cold then cover him. If the victim is feeling hot then don’t make 

suffocation by covering him.  
• If the victim starts vomiting then move the victim to the suitable place.  
• Loosen the tight clothing.  

 

Muscle Cramps  
• Stretch out the affected muscle of the victim to counterbalance the cramp part of the body.  
• Firmly massage the cramped muscle.  
• Apply some kind of moist heat on the affected area.  
• If the cramp remains in the muscle, get medical help as soon as possible.  
• Rest- avoids movements and activities that cause pain.  
• Apply the ice on the cramped muscle it may reduce the pain and swelling of the muscle.  
• Applying the light compression like elastic bandage on the affected area may reduce the 

swelling.  
• Raising the affected area above the heart level may reduce the swelling as well as pain.  

 

Fractures  

As we all know about the fracture that is the crack or break in the bone.  

Dislocation  

A dislocation occurs when the bone slips out from the specified location. It generally occurs in the 
shoulders, thumb, elbow, fingers, lower jaw and other movable joints.  

First Aid for Dislocations & Fractures:  
• Immobilize the effected part.  
• Stabilize the effected part  
• Use a cloth as a sling.  
• Use board as a sling.  
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5.1.4 First Aid 
First aid is the assistance given to any person suffering a sudden illness or injury with care provided 

to preserve life, prevent the condition from worsening, or promote recovery. 

Kits vary in contents but most kits have the following items:  

• Band-aids / Adhesive bandages  
• Gauze pads and tape  
• Scissors, cold pack  
• Wound bandage / compress  
• Eye pads / eye wash solution  
• First aid / burn cream  
• Antibiotic ointment  
• Face shield or barrier mask for providing CPR  
• Forceps / tweezers  
• Disposable thermometers  

• First aid instruction booklet 

 . .  Personal Protective Equipment’s (PPE) 

Personal protective equipment (PPE) refers to protective clothing, helmets, go ggles, or other 

garments or equipment designed to protect the wearer's body from injury or infection. The safety 

by protective equipment includes electrical, heat, physical, biohazards, chemicals, and airborne 

particulate matter.  

 

Figure 5.1.3 Personal Protective Equipment’s 
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In the workplace, there are many situations which require immediate first aid to the victim and 

many countries have made some regulation, legislation, and guidance which specify the minimum 

level of first aid to be given to the victim. For this, the worker needs the special training and area for 

achieving the immediate first aid. Go achieve this, the training should be given by specialist first aid 

officer and necessary training given by learning institute. The training of first aid does not need any 

type of specific tools and equipment but may involve the improvisation with material offered at the 

time of training. 

 

Figure 5.1.4 First Aid pyraimid 

While delivering First Aid always remember:  

• To prevent from degradation.  

• Act deliberately and confidently with the victim.  

• The timings of Golden Hour should be first 60 minutes from an accident .  

• The timings of Platinum Period should be first 15 minutes following an accident.  

• Prevent the body shock and choking.  

• Stop bleeding from the wound.  

• Loosen the clothes of victim.  

• Regulate the respiratory system of the victim.  

• Avoid crowding near the victim.  

• Take the victim to safe place or hospital near the workplace.  

• Attend the emergencies situation with ease and without fear.  

• Always remember to not overdo. Because the person giving the first aid is not doctor.  
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Exercise  
1. Discuss some general safety rules for working in the workshop. 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. What is PPE and are the common components of PPE? 
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3. What is an accident and what are the types of accidents? 

 

 

 

 

 

 

 

 

 

 

4. Discuss the types of fire-extinguisher and their uses? 

 

 

 

 

 

 

5. Write a short note on health and hygiene? 

 

 

 

 

6. What are the common components of First-Aid kit? 
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7. What are the symptoms of shock and what should be the first-aid? 

 

 

 

 

 

 

 

 

8. What are the symptoms of heat exhaustion and what should be the first-aid? 
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